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 Welcome to the world of TK-78K0R/KG3+UD. 
  
You are now being navigated to the design environment 
of the 78K0R microcontroller for developing wireless 
network applications. Please follow the tutorial step by 
step. 
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[NOTES] 
The information in this document is subject to change without notice. No part of 
this document may be copied or reproduced in any form or by any means without 
the prior written consent of TESSERA TECHNOLOGY INC. 
TESSERA TECHNOLOGY INC. assumes no liability for infringement of patents or 
copyrights of third parties by or arising from use of a product described herein. 
This product is designed and manufactured with intention for use in evaluation 
and prototyping by engineers with knowledge of security, safety and reliability. 
TESSERA TECHNOLOGY INC. would like to inform, that the standard quality 
assurance procedure(s) have not been fully applied to this product and its 
documentation and that TESSERA TECHNOLOGY INC. cannot assure the full 
and error free function and/or the standard quality level. 
[CAUTION] 
This equipment should be handled like a CMOS semiconductor device. The user 
must take all precautions to avoid build-up of static electricity while working with 
this equipment. All test and measurement tool including the workbench must be 
grounded. The user/operator must be grounded using the wrist strap. The 
connectors and/or device pins should not be touched with bare hands. 
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1 Introduction 
 
 
 
Target Reader Software development engineers who wish to become 

familiar with the development environment of the 78K0R 
microcontrollers. It is assumed that the readers have been 
familiar with basics of microcontrollers, C and assembler 
languages, and the WindowsTM operating system. 

 
Purpose For readers to become familiar with the design environment 

and the application examples of wireless networks. 
 
 
Overview This manual consists of the following contents 
 
Chapter 1 Introductions 
              →Overview of this manual 
 
Chapter 2 Preparations 
              →Introduction of soft tools, and sample programs and installation 
 
Chapter 3 Experiences 
              → Guide to the basic operations of PM + and the integrated 

debugger using sample programs. 
 
Chapter 4 Hardware Specifications

→Explain the hardware of TK-78K0R/KG3+UD 

 
Chapter 5 IEEE 802.15.4 MAC Sample Programs                                           
              → Learn sample programs, which utilize the MAC library 
 
Chapter 6 Troubleshooting

→Describe how to solve troubles you may face, such as errors when 

starting the integrated debugger (ID78K0R-QB) 

 

Chapter 7 Other Information

→Introduce other information, such as how to create a new 

workspace (project) on integrated development environment (PM+), 

how to register additional source file, and some useful tips of the 

integrated debugger. 

The circuit diagrams of demonstration kit are included in this 

chapter. 
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Chapter 8 Mode Setting of the Board 
  → Explanation of switch setting. 
 
 
Trademark Microsoft and Windows are either registered trademarks or 

trademarks of Microsoft Corporation in the United States and/or 
other countries. 
Adobe and Acrobat are trademarks of Adobe Systems 
Incorporated (Adobe System Incorporated). 
Other company names and product names that appear in this 
document are the registered trademarks or trademarks of their 
respective companies. 
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2 Preparations 
 

 
This chapter introduces the development environment and describes how to 
install the sample programs. The sample program can be tested on this 
hardware platform of the evaluation kit. 
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2.1 Development Tools, Sample Programs, and the MAC Library 
 
 
 

 
This section outlines the development tools, sample programs and the MAC 
library used in this tutorial.  

 

2.1.1 Integrated Development Environment PM + V6.31 
This is a project manager, where you work for editing the source code, 
compiling it, and initiating the debugger. The project manager works on MS 
Windows 2000 or XP.  

 

2.1.2 Device file DF781188 V3.00 
A device file contains an MCU specific information. It instructs the 
development tools what kind of an MCU the tools shall work for.  

 

2.1.3 C Compiler CC78K0R W2.12 : Code size limited version 
This is a free compiler for the 78K0R microcontrollers. The object code size 
is limited to 64 Kbytes. It works on MS Windows 2000 or XP. 

 

2.1.4 Assembler RA78K0R W1.33 : Code size limited version 
This is a free assembler for the 78K0R microcontrollers. The object code 
size is limited to 64 Kbytes. It works on MS Windows 2000 or XP. The 
RA78K0R Assembler Package contains Structured Assembler 
Preprocessor, Assembler, Linker, Object Converter, Librarian, and List 
Converter. 
 

2.1.5 78K0R integrated debugger ID78K0R-QB V3.60 
The Integrated Debugger ID78K0R-QB offers a debug environment on 
your PC, where the MS Windows 2000 or XP runs, if the TK board is 
connected to the PC with USB. The USB I/F accesses to the OCD, On 
Chip Debug, interface on the microcontroller.  

 

2.1.6 78K0R Starter Kit Setting 
If you forget about the security ID or if you set “Does not erases data of 
flash memory in case of failures in enabling on-chip debugging”, you can 
erase the flash memory by using this starter kit. 

 
 

- 11 - 



2.1.7 Starter kit USB driver  
This is a software driver for PC to access to the USB interface of the 
TK-78K0R/KG3+UD board.  

 

2.1.8 The RF Test Program 
The RF Test Program is used in [chapter 3 Experiences]. 
 
The RF Test Program is provided in the form of the C source codes.  
 
If you wish to tailor the RF Test Program to meet your specific needs, you 
can edit the source code, re-compile it with debug build to generate a load 
module file, then, start the debugger to load the tailored execution code on 
to the microcontroller for further debugging on the project manager PM +. 
 
Alternatively, if debugging is not required, you can make a release build to 
achieve a new hex file, on the project manager PM +. 
 

As a general remark, please respect your local regulation of 
electro-magnetic emission. In general, it is suggested to use the 
TK-78K0R/KG3+UD board in a radio anechoic chamber. 
 
 

2.1.9 IEEE 802.15.4 MAC Library 
The IEEE 802.15.4 MAC Library offers an executable object-code library of 
the MAC stack specified in the IEEE 802.15.4. Please refer to the MAC 
Library manual for further details. 
 

2.1.10 The MAC Sample Program1 : Text Chat Program 
The MAC Sample program 1 is developed to provide with a simple 
example to construct a star network utilizing the IEEE 802.15.4 PHY/MAC 
standard. 
 
The MAC Sample Program 1 offers, 
1). Designation of a network coordinator in a star configuration 
2). Text chat between a coordinator and an end device 
 
To use the MAC Sample Program 1, you need to prepare at least two PC 
with a USB interface and two TK-78K0R/KG3+UD boards.  
The MAC Sample Program 1 is provided in the form of the C source 
codes.  
 
If you wish to tailor the sample program to meet your specific needs, you 
can edit the source code, re-compile it with debug build to generate a load 
module file, then, start the debugger to load the tailored execution code on 
to the microcontroller for further debugging on the project manager PM +. 
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However, because the USB connection to instruct operation to the program 
is occupied for the debugging purpose,  
alternatively, you can make a release build to achieve a new hex file, on 
the project manager PM +. 
 

As a general remark, please respect your local regulation of 
electro-magnetic emission. In general, it is suggested to use the 
TK-78K0R/KG3+UD board in a radio anechoic chamber. 
 
 
 

2.1.11 The MAC Sample Program2 : LED Control 
The MAC Sample program 2 is developed to provide with another simple 
example to construct a star network utilizing the IEEE 802.15.4 PHY/MAC 
standard. 
 
The MAC Sample Program 2 offers, 
1). Designation of a network coordinator in a star configuration 
2). LEDs on the coordinator board indicate which switch on which end 

device is pressed. 
 
To use the MAC Sample Program 2, you need to prepare one PC with a 
USB interface and two TK-78K0R/KG3+UD boards or more boards, up to 
5.  
The MAC Sample Program 2 is provided in the form of the C source codes.  
 
If you wish to tailor the sample program to meet your specific needs, you 
can edit the source code, re-compile it with debug build to generate a load 
module file, then, start the debugger to load the tailored execution code on 
to the microcontroller for further debugging on the project manager PM +. 
However, because the USB connection is occupied for the debugging 
interface, the USB connection is not available for applications. Alternatively, 
you may make a release build to achieve a new hex file, on the project 
manager PM +. 
 

As a general remark, please respect your local regulation of 
electro-magnetic emission. In general, it is suggested to use the 
TK-78K0R/KG3+UD board in a radio anechoic chamber. 
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2.2 Installation of Software Development Tools 

 

 

2.2.1 Start-up of the installation CD-ROM 
 
The attached CD-ROM contains Development Tools, documents and sample 
soft ware.  
You can install it using an installer. 
 

2.2.2 Installation of the software development tools. 
 
Please insert the CD-ROM in the drive. The installer will show up automatically. 
If it does not start automatically, please initiate it by double clicking the 
SETUP.EXE. 

 

 
 

 
<1> Readme First 

The contents of the CD-ROM, and some notes are available. 
Please read it at first. 

<2> Install… 
Click “Install” to start installation of development tools. 
For details, please refer to the next section. 
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<3> Documents 
Manuals of development tools and the evaluation kit are available in PDF 
files. 
When this button is clicked, the WWW browser will start. Adobe® Acrobat® 
Reader is available in the CD-ROM. 

     
<4> Sample Program 

Click this button to start the WWW browser for the sample program and the 
tutorial. 

<5> Link to NEC Electronics Microcontrollers   
Click this button to start the WWW browser display the link to the NEC 
Electronics Microcontroller web site 
(http://www.necel.com/micro/index_e.html) 
The NEC Electronics Microcontroller web page provides with the latest 
product/tool information and FAQs.   

<6> Exit  
Terminate the setup. 
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① Select products that you need to install. 

(as default, all the products that you need to use the demostration kit 
are selected.) 

"Explain" area displays an explanation of the selected product. 
To change the installation destination, click  Browse…  . 

 
When all the settings are completed, click  Install…  .  
 

* In this document, it is assumed that users install the programs under "NEC 
Electronics Tools" directory (default installation directory). Users can find the 
tools by selecting “Start Menu” -> "Programs" -> "NEC Electronics Tools".  

 
 

 

 
 

 

 

 

- 16 - 



② Click  OK  when "Install" comfirmation dialog box is opened. 
 

 
 
 

③ Read "software license agreement" and click  Yes  for continuing the 
installation.To stop the installation, click  No  .  
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④ Enter the product ID, and click  Next  . 
* The product ID is available on the “README.html” the other sheet. 

 

 
 
 

⑤ It starts copying the files.  
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⑥ Click  Next  when "Select Files" installation wizard dialog opened. 

 
 

 
⑦ When the installation is completed, the following dialog opens. 

Click  OK  .  
 

 
 
 

⑧ "NEC Electronics Starter Kit Virtual UART" USB driver must be installed on 
PC before you connect to TK-78K0R/KG3+UD. Install the USB driver by 
referring "2.3USB Driver".  
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 Notes on the installation authority  
To install this tool in Windows 2000 or XP, the authority of a administrator is 
necessary. Therefore, please login as an administrator. 
 
 Notes on the install-directory  
Please do not use 2-byte characters, such as umlaut in the directory name, 
where the product is to be installed. 
 
 Note on the version of Windows  
If the language of the Windows is not English, a file transfer error during 
installation might be observed. In this case, please abort the installation in 
the language, and re-install it in an English version of Windows. 
 

The identical problem may be observed, if a language other than English is 
specified as the system language in the “Regional Settings Properties” tab. 
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2.2.3 Uninstall 
 
<1>  Start "Add /Remove Programs" in the Control Panel. 

(Example here is based on Windows2000) 
 

 
 
<2>  Select the tool that you want to uninstall from the list displayed in 

"Install/Uninstall" and click [Add/Remove...]. 
 
 
<3>  A dialog box for confirming deletion of files will be displayed.  Click    

Yes   .  Deleting of the files will be started. 
 

 
 

 
<4>  When the completion message is displayed, click    OK   . 

 
Caution: 
Deletion of some files may be asked during uninstallation.  Normally, 
deletion of these files causes no problem.  

 
<5>  This completes uninstalling this tool. 
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2.2.4 File Configuration in PC 
 

Software Development Tools are installed in "C:¥Program Files¥NEC Electronics 
Tools" on default setting. 
When you use the tools, please open the tools from [Start menu] -> 
[Programs]->[NEC Electronics Tools]. 
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2.3 USB Driver 
 
 
 
You need to install “NEC Electronics Starter Kit Virtual UART” in your PC.  
 
When TK-78K0R is used, it is necessary to install the “NEC Electronics Starter Kit Virtual 
UART” driver in the host machine. Please install the driver according to the following 
procedures with appending CD in the drive. 

 
"Starter Kit USB Driver" must be installed on the PC. If not, please refer to "2.2 Installation of 
Software Development Tools" to install the “Starter Kit USB Driver” first.  

 
Attention  Do not use a USB hub for connecting TK-78K0R/KG3+UD. 

 
 
Depending on the version of Windows OS, the installation will be differed.  
Please check your Windows version, and follow the instructions 
   - Windows XP   -> "2.3.1Install to Windows XP" 
   - Windows 2000 -> "2.3.2Install to Windows2000" 
After the installation, go to "2.3.3Confirmation of the installation" 
 
 
 8
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2.3.1 Install to Windows XP 
 

１． Once the TK-78K0R/KG3+UD is connected with USB, the "Found New Hardware 
Wizard" will be started. Select "No, not this time" and click  Next >  .  

 

 

Select "No, not this time" 

Click "Next" 
 

 
 
２． Select "Install from a list or specific location" and click  Next >  .  
 

 

Select "Install from a list or specific 

location" 

Click "Next" 
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３． Select "Search for the best driver in these locations.” , check "Include this location in 
the search:", and then click "Browse..." to select the driver directory path. The path 
should be "C:¥Program Files¥NEC Electronics Tools¥TK-driver" as default installation. 
If the installation directory is not default, then select "TK-driver" under the installation 
directory.  
Click  Next >  . 

 

 

Select the driver directory 

Click "Next" 

 
 
４． If the following dialog is opened, click  Continue Anyway  .  

 

 

Click "Continue Anyway" 
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５． The installation of "NEC Electronics Starter Kit Virtual UART" driver is completed.  

Click  Finish  . 
 

 

 

Click "Finish" 

 
６． Go to "1.3.3 Completion of the installation". 
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2.3.2 Install to Windows2000 
 

１． Once the TK-78K0R/KG3+UD is connected with USB, the "Found New Hardware Wizard" 
will be started.  
Select "No, not this time" and click  Next >  .  

 
 
 

 

Click 
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２． Select "Search for a suitable driver for my device". 
Click  Next >  .  

 

 
 
 

Select "Search for a suitable driver for my 

device" 

Click "Next" 

３． Select "Specify a location". 
Click  Next >  .  

 
 

 
 
 
 
 

 
 
 
 

Select "Specify a location" 
 

 
 
 
 

Click "Next"  
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４． Select the driver directory path. The path should be "C:¥Program Files¥NEC 
Electronics Tools¥TK-driver" as default installation. 
If the installation directory is not default, then select "TK-driver" under the installation 
directory.  
Click  OK  . 

 

 

Click "OK" 

Select the driver directory 

 
 
 
 
 
５． Click  Next >  .  
 

 

 

Click "Next" 
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６． The installation of "NEC Electronics Starter Kit Virtual UART" driver is completed.  
Click  Finish  . 

 

 

Click 

 
 
 
 
７． Go to "1.3.3 Confirmation of the installation". 
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2.3.3 Confirmation of the installation  
 
Please confirm “NEC Electronics Starter Kit Virtual UART(COMx)” in the device 
manager of system in the control panel of the MS Windows.  
 
 

Device Manager 

 

It is confirmed that “NEC 

Electronics Starter Kit Virtual 
UART(COMx)” exists.  

 
The screen above shows that the COM port number is "COM8". If ID78K0R-QB is 
not in use, you can use this port number for connecting TK-78K0R/KG3+UD. 
When you change the USB port connection, the COM port number will be 
changed as well. 

 
 

CAUTION 
・Do not do “Hardware Modification Scan” when you communicate with the target device. 
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2.4 Sample Environment 

 

 

 
This section explains the overview and preparation of sample programs. 
You need to install the sample programs on your system first before using them. 

 
How to install the sample programs and where they should be intalled on your 
system will be explained. 
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2.4.1 Installation of the sample programs 
Insert the CD-ROM disk in the CD-ROM drive of your PC. The [NEC Electronics 
Microprocessor Development Tools Setup] screen automatically appears.(if this screen does 
not appear automatically, start setup.exe from Explorer. etc.) 
Press the  Sample Program  button to start the WWW browser, and then click the 
[TK-78K0R/KG3+UD Sample Programs] link.  

   

The WWW browser 
starts up. 

 

 

Click the [TK-78K0R/KG3+UD 
Sample programs] link you can also 

download the [User's Manual] 

 
When[TK-78K0R/KG3+UD Sample Programs] is clicked, the following 
download confimation window appears. 
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Please click the Open button. 
In case of windows 2000, 

you will see the [Security Warning] window. Please click  Run . 
 

 
 

 
 

InstallShield wizard for TK-Sample Program starts up  
Please click  Next. 
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License agreement screen is displayed. 

Please select "I accept the terms in the license agreement".and click Next. 
 

 
 

 
 

Please click Finish. 
 
 
The sample programs are installded under "C:¥" now. 
 
The sample program "TK78K0R.EXE" with self-extract file is also intalled. When 
you need to use the original sample programs, you can extract the file 
"C:¥TK78K0R.EXE". 
 
When you uninstall the sample program. 
Please use "Add /Remove Programs" in the Control Panel. 
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2.4.2 File Configuration of the sample program 
 
The sample programs ware the following folders. 
 

 
 
 
 
 
 
 
 
 
 
 

and LED is blinked.. 

TK78K0R 

SAMPLE_KG3+UD 

 

TK78K0RUD_RF_Test The sample program used in chapter 3. 

The packet error rate and received signal 

strength indication are monitored.  

TK78K0RKG3UD_Sample1 This sample program uses MAC library. 
The text message is transmitted and it receives it. 

TK78K0RKG3UD_Sample2This sample program uses MAC library. 

Switch information is transmitted, it receives,  
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3 Experiences 
 
 
Now you are ready to experience the operation of the TK-78K0R/KG3+UD using 
the integrated development environment, PM +. 
 
As a program for the 78K0R/KG3, the RF test program (RF_Test) which you 
installed in "2.4.1Installation of the sample programs" is used. 
You use two of 78K0R/KG3. One is the stand-alone system with USB power 
supply. Another is connected to the debugger and run user programs. By building 
the sample programs and operating with ID78K0R-QB, you can understand the 
basic operation of the development tools (PM+, ID78K0R-QB) and the basics of 
the project files that you need when you develop application programs. 
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The overall flow is as follows. 

 

 
Starting PM + 

 

 

 

Loading workspace (project) 

Creating execution format 

Reviewing Linker, Compiler option, Debug setting

TK board setting

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Starting integrated debugger (ID78K0R-QB) 

Executing program 

Stopping program 

Operation 

Terminating integrated debugger (ID78K0R-QB) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Terminating PM +
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3.1 Starting PM + 
 
 

 

In the Windows Start menu, select [Programs]->[NEC Electronics Tools]->[PM + 
V6.31] 

 
 
 
 
 

 

PM + start up 
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3.2 Introduction to PM + 
 
 
 
In PM +, application programs and environment setting are handled as a single Project, and series of actions 

such as program creation using the editor, source management, build, and debugging are managed. 

Also, one of more project files is managed together as a workspace. 

 

 

 

 

Menu bar 
Tool bar 

Output window Project window  
 
 
Project window A window in which project names, source files, and include file are displayed using a 

tree structure. 

Output window A window in which the build execution status is displayed. 

 

For details regarding menu bars and tool bars, refer to the PM + User’s Manual. 
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What is a project? 

A project is the unit in which PM + executes management, and refers to an application system 

and environment development based on PM +. 

PM + complies project information and saves it in a “project file”, from which it is then referenced. 

 

What is a project file? 

A project file is a file to which information such as the source file to be used in the project, the 

device name, the tool options for complying, and the editor and debugger to be used have been 

saved as “project information”. 

The file name format is “ΔΔΔΔprj”. 

Project files are created in folders that are set when creating new workspaces. 

 

What is a project group? 

A project group is a group comprised of a number of projects in an application system. 

The target devices of each project that can be registered to one project group must be the 

same. 

 

What is a workspace? 

A workspace is the unit used to manage all the projects or project group required for one 

application system. 

The file name of multiple project files is saved to a workspace file for referencing. 

The file name format is “ΔΔΔΔprw”. 
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3.3 Loading Workspace (Project) 
 
 

 
In this section, you will use the workspace that you created in "2.4.1Installation of the sample 
programs" 
For creating a new workspace, refer to "7.1Create a new workspace". 
The workspace has information about the build environment for the sample programs. 
Select "File" on menu bar and "Open Workspace…". 
Then, select 
“C:¥TK78K0R¥SAMPLE_KG3+UD¥TK78K0RUD_RF_Test¥RF_Test.prw” . 
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Open the folder in which the 

sample program is located. 

 
“RF_Test.prw”and then press the  Open  button. 

 
 

 

 

Workspace file name :RF_Test.prw 

Project group 

Project 

The “RF_Test.prw” workspace 

file is read 
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3.4 Configuration of Linker Option 
 
 
The linker options have been set by the project file. However, some option settings will be 
covered in this section because the linker option settings are important for debugging. 
Following three settings are covered specifically. 
  - Outputs from debugging 
  - On-chip debug (bytes, security ID) 
  - Watchdog timer 
 
Select "Tools" on menu bar, then "Linker options". 
 

3.4.1 "Output1" Tab 
Select "Output1" tab on "Linker Options" window, and see following settings. 
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  - Load Module File settings 

Check "Output Symbol Information". 
This enables to do source level debugging (setting break points, monitoring variables in 
watch window, etc). 
Also, you can specify the load module file name.  
 

  - On-Chip Debug Option Byte 
Check "On-Chip Debug Option Byte". Enter "85" in "Control value". This setting enables 
the on-chip debugging function of the microcontroller. 
    *For details of "Control value", refer to the user's manual of 78K0R/KG3 (U17894E). 
See "Start address" is set to "7FC00", and "Size" is set to "1024". 
These settings reserve the memory address area for the monitor program (the flash 
memory area that the debugger uses for on-chip debugging). 
In this case, the "Control value" is allocated to the address of C3H in flash memory, and 
FFH is set to the next address. Because of this, the following areas could not be set the 
segments. 
<Address area that reserved by on-chip debugging> 
  - 2H, 3H 
  - CEH-D7H 
  - From the address set in "Start address" to the byte set in "Size" 

 
  - Security ID 

Check "Security ID", and enter the security ID which is a unique ID code (10 bytes) to 
authenticate when the debugger is launched.  
The security ID is stored in the flash memory (C4H-CDH), and checked if it is the same 
as the code entered in Linker options dialog when the debugger is launched. 
The debugger will not be launched when the security ID is unmatched. By using this 
function, you can secure the programs from leaks. 
If you do not need to set the security, it is recommended to set the security ID 
"FFFFFFFFFFFFFFFFFFFF" as this is the initial code. 

 
If you forget about the security ID (stored in the address of C4H-CDH) or if you set wrong 
on-chip debug option byte, you will not be able to use the debugger (ID78K0R-QB). 
To solve this, you can use the "78K0R Starter Kit Setting" for changing the setting to initialize 
the flash memory at the time debugger launched. 
For details, refer to "7.4Erase of flash memory". 
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3.4.2 "Output2" Tab 
Select "Output2" tab on "Linker Options" window, and see following settings. 
 

 
 
  - User Option Byte 

Check "User Option Byte", and then enter "00FFFF". Here, you can do the 
setting of watchdog timer, low-voltage detector, and system reserved 
memory area. The 3 bytes you entered are stored at C0H-C2H on flash 
memory: 
  - C0H: setting for watchdog timer 
  - C1H: setting for low-voltage detector 
  - C2H: setting for system reserved memory area (must be set as FFH) 
This time, you disabled the watchdog timer and the default start function of 
low-voltage detector. 
For details, refer to the user's manual, 78K0R/KG3 (U17894). 
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3.5 Configuration of Compiler Option 
 
 

 
The compiler options have been set by project file. However, because some compiler options 
are useful, following two settings are covered specifically in this section. 
  - Enable C++ comments 
  - Use multiplier and divider 
 
Select "Tools" on menu bar, then "Compiler options". 
 

3.5.1 "Extend" Tab 
Select "Extend" tab, and check "Enable C++ Comment". 
This setting allow you to use the C++ comment using "//". 
It is useful feature when developing code. 
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3.5.2 "Startup Routine" Tab 
 
Select "Startup Routine" tab, and check "Using Library" and "Using 
Multiplier/Divider". The 78K0R/KG3 has feature of multiplier/divider to increase 
those calculation speed. 
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3.6 Configuration of Debugger setting 
 

 
 
 
Please Choose [Tool] -> [Debugger Setting] at the pull-down menu. 
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Check if "ID78K0R-QB V3.60 78K0R Integrated Debugger" is selected on "Debugger". 
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3.7 TK board setting 
 

 
Please set the switches on the TK-78K0R/KG3+UD board as follows. 
 
 
 JP1 1-2 short (USB side) 

Bit1 ON 
Bit2 ON 
Bit3 ON 
Bit4 OFF 
Bit5 OFF 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

  
 

 

 

 
SW1 

 

JP1 

 

 

 

 

 

 

 

 

 
 
After the switch settings are completed, connect the PC to USB1 on 
TK-78K0R/KG3+UD with USB cable.If the "Found New Hardware Wizard" is 
started, install USB driver with referring "2.3USB Driver". 
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3.8 Creating execution format 
 
 
 
Please go back to PM +. 

Please re-compile the project by clicking the  button at the menu bar. 
 

 

Build process is  

executed 

 

 
Build has been completed successfully.
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What is build ? 
Build is a function that creates an executable file, etc., from a source file registered to a project. 

PM + automatically performs compiling, linking, and other processing actions. 

On the second and subsequent build, PM + also automatically delects files that have been updated  

from the previous build processing, and complies and assembles only the relevant files, thereby reading 

the time required for build processing.  
 
 

What is rebuild ? 
Build compiles and assembles only the source files that have been updated since the previous 

time, whereas rebuild compiles and assembles all the source files.  

When setting, such as compiler options, have been changed, not build, but rebuild, must be  

Selected. 
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3.9 Starting integrated debugger (ID78K0R-QB) 
 
 
 
Please select the Debug button  ，of PM +, or in the menu, select [Build(B)]
→[Debug(D)]. 
 

If the debug button is not displayed, in the menu, select [Tool]→[Debugger 
Setting...]“ID78K0R-QB V3.60 78K0R Integrated Debugger” 

 

 

 

 

  ID78K0R-QB is launched 
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"Configuration" dialog is opened. 
Enter "FFFFFFFFFFFFFFFFFFFF" (F x 20) in "ID Code", then click  OK  . 

 

 
Click  Yes  when the confirmation dialog for downloading load module file is opened. 
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ID78K0R-QB starts and downloading 
the program to flash memory. 

 

 

 

 
When the download is 
completed, the source 
code will be displayed  

 

 
 
 
NOTE: 

Completion of the download does not mean running the programs. To run the sample 
programs, go to "3.11 Executing program". 
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Normally, if communication with the CPU fails, the following error messages are 
output. 
 

 
 
If you observe the message please confirm the following items.  
 
 
 
1． Please confirm the switch on the board is set as follows. 
 

JP1 1-2 short (USB side) 
Bit1 ON 
Bit2 ON 
Bit3 ON 
Bit4 OFF 
Bit5 OFF 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 

 
 
 
 
 
 
 
 
 
 
 
２．  Please confirm the power LED1 is lighted. 
 
 
After checking the above items, start ID78K0R-QB again. 
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If the ID code is wrong, you may find the following messages on the display. 
 

 
 

The following "Configuration" screen is displayed when OK is pushed and input a correct ID 
code, please. 

 
 

The default setting of the ID code is ”0xFFFFFFFFFFFFFFFFFFFF”. You can set an 
alternative ID code on the linker option tab. 
 
If the setting of On-Chip Debug Option Byte is "Does not erase data of flash memory in 
case of failures in enabling on-chip debugging" and if you forget the security ID, 
you need to erase the flash memory completely. 
To erase the flash memory, please refer to the section 7.4, “Erasing the Flash Memory”. 
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3.10 Introduction of the integrated debugger(ID78K0R-QB) 
 
 
 
ID78K0R-QB displays the internal status of the CPU and controls monitor 
functions in the main window.  
The initial screen of ID78K0R-QB is as follows.  
 
< Main window＞ 

 
Status bar 

Menu bar 

Window display area 

Tool bar 

 
 
 

 
For more details, please refer to the user’s manuals of ID78K0R-QB. 
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3.11 Executing a program 
 
 

If you click “GO” , the execution of the code will start. 
You can know it by the red bar at the bottom. 

 

 

 

 
 
 

Execute the program 

While a program is running, the status bar will be red. 
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3.12 Stop a program 
 
 
Now, you are going to stop the program. 
Press the ID78K0R-QB’s stop button , or in the menu, select [Run]→[Stop]. 

 

 

 

Stop the program 

 
When the program stops, the status bar changes back to the original color. 
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3.13 Terminating integrated debugger (ID78K0R-QB) 
 
 

Select "File" on menu bar, then "Exit". 
 

 
 

The Exit confirmation dialog box is 
displayed. 

 

 
 

 
 
 
If you push the “Yes”, ID78K0R-QB is terminated after preserving a present 
environment.  
If you push the “No”, ID78K0R-QB is terminated without preserving a present 
environment. 
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3.14 The RF Test Program 
 
 
 

3.14.1 Procedure for one to one transmit/receive test 
 

1). Assumption here in this section is, you have two TK-78K0R/KG3+UD 
boards, in one of which the execution code for the “RF_TEST” was 
programmed by the debugger. You also prepare two PCs or one PC with 
more than one usb interface. 
one PC with USB interface and hyper-terminal to control the transmitter side 
of the board, and the other one with USB interface to the second PC for 
debugging at the receiver board. 

 
 

Execute terminal software. 

Transmitter use as Stand alone. 

Execute ID78K0R-QB. 

Receiver Debugger use.  
 
 

 
 
 Short address : 0001 Short address : 0002 

 
2). Now, you designate one TK-78K0R/KG3+UD board loaded with the 

execution code in the previous procedure as a transmitter. Another board, 
which is not loaded with the execution code is now designated as a receiver, 
which send back the test result to the sender. The receiver board can work 
without PC, but now, you set this board to the debug mode. Please set the 
switches on the receiver board as follows. 
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JP1 1-2 short (USB side) 

Bit1 ON 
Bit2 ON 
Bit3 ON 
Bit4 OFF 
Bit5 OFF 
Bit6 ON for address setting 
Bit7 OFF for address setting 

SW1 

Bit8 ON for the receive mode 
 
 
The above example is for the short address of 0002. 
There are four ways of the address setting as follows, 
 

Short Address 
 

0001 0002 0003 0004 
Bit6 OFF ON OFF ON 

SW1 
Bit7 OFF OFF ON ON 

 
Please connect the receiver board to your first PC with a USB cable. 
Now, please repeat the procedures described in the section “3.9 Starting 
integrated debugger”. 
You will see the C-source window, as shown below. 
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Now, please click “GO” to run the program. 
 
 

 

 
 

You will see the red bar at the bottom. 
 
Now the receiver board is ready. 
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3). Please set the transmitter board as follows, 
 

JP1 1-2 short (USB side) 
Bit1 OFF 
Bit2 OFF 
Bit3 OFF 
Bit4 ON 
Bit5 ON 
Bit6 OFF for address setting 
Bit7 OFF for address setting 

SW1 

Bit8 OFF for the Hyperterminal mode 
 
 
This example is for the short address of 0001. 
This board is designated as the transmitter. 
 
Then, please connect it to your second PC with a USB cable. 
 
Then, please identify the COM port number of the USB in your PC  
at [Control Panel]  [System]  
 
 
 

4). Hyper Terminal 
 
On MS-Windows in your PC, please select [All Programs] -> [Accessory] -> 
[Communication] -> [HyperTerminal] 
 
Setting of Hyperterminal 
  

 Bits per second 115200 

Data bits 8 

Parity None 

Stop bits 1 

Flow control None 

 
 
 
 

 
 (Property -> Setting -> ASCII) 
 Local Echo OFF 
 No Line Feed 
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Now you will find the following opening menu in the window. 
If not, please try the RESET button on the board. 
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5). Execution of the Transmit/Receive Test 
 
To initiate the PER, Packet Error Rate, test, please press “1” in the menu.  
You will see [My Profile], 
then, be asked for the destination of the PER test, as shown below. 
 

 

 
 
Now, you may input “0002”. 
Then, you will be asked how many packets you wish to consume in the PER test. 
You may input “1000”. 
Then, you will be asked the interval of packets in msec. 
You may input 3 msec. 
Then, the PER test will be executed.  
You will see, 
the number of packets sent, that is, 1000 as you input, 
the number of the received packets, 
the calculated PER in % 
and the maximum and minimum RSSI values in the PER test. 
 
[Note]  
PER= Packet Error Rate 
RSSI= Received Signal Strength Indication 
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RSSI is expressed in the hexagonal value of 256 levels, which indicates the signal 
strength in the received signal. For more details of the RSSI value, please refer to 
the datasheet of the UZ2400 RF chip. 
 
Please note the PER and the RSSI are measured at the receiver side. 
The receiver does not send back the test packets, but only the test result. 
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6). Channel setting 
 
In the previous example, you may have also found the RF channel used in this 
test is the Channel 11. The channel is specified by the IEEE 802.15.4 
specification. 
The channel 11 is assigned at 2405 MHz. You can change the channel in the PER 
test in 5MHz step to the maximum channel of 26th at 2480 MHz. 
To do it, please press “A” in the command prompt. Then, please choose the 
channel by [+], [-], [A], [B], or [C]. In the example below, the channel 23th, 2465 
MHz, was selected.  
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To execute the PER test at the channel 23, press [Enter] in your keyboard, then, 
choose “1” to initiate the PER test mode. Then, you may input 1000 packet in 5 
msec interval to see the following example. Please confirm the channel used is 
23th in the display. Please note the receiver will learn which channel is to be used 
for the test automatically. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

[My Profile] 
------------------------------------- 
  MAC : 22:95:78:01:00:00:00:47 
Short : 0001 
PanID : 2514 
------------------------------------- 
Send to (Short addr) ? : 02 
Send count (dec)     ? : 1000 
Interval (dec/msec)  ? : 5 
[Set channel to 11 (Cmd)] 
Prepare to send..OK 
[Set channel to 23 (Current)] 
Send..     0 
Request to result..OK 
 
 
[Results] 
------------------------------------- 
From     : 0001 
To       : 0002 
------------------------------------- 
Sent     : 1000 
Recieved : 1000 
PER      :   0.0000% 
RSSI     : max FF / min FF 
------------------------------------- 
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7). Adjusting the output power 
 
You may wish to control the output power in the PER test.  
For it, please select “M” in the menu. 
You will be asked the register ID. Please input “274”. 
Then you will see, “LREG[203] : 00 >”. 
It means the current value at the register [274] is 0xC4h, which means 0 dB. 
0xC4h is the reset default. 
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The register bits are defined as follows, 
 
LREG[274]: [7:6] -> large scale tuning 

C4: 0 dB  
81: -8 dB 
09: -16 dB 
01: -24 dB 

 
LREG[203]: [7:3] -> small scale tuning 

000000: 0 dB 
000001: -0.1dB 

| 
111111: -8.00 dB 
 

For instance, if you wish -8 dB, please input “81”, as follows, 
 
“LREG[274] : C4 > 81”  
 
Then, you will start the PER test. 
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You may find larger PER value with smaller RSSI value in this case. 

 
Please note this adjustment is applied only to the transmitter. The receiver always 
sends back the test results with the 0 dB output power using the channel 11th. 
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3.14.2 PER test / receiver 
 
The Menu 2 sets the board to the receiver in the PER test. 
If you have two PCs, you can connect two boards to each of two PCs, then, 
you will apply this mode to one of them.  
In your current case, your receiver board is now being connected to the 
debugger. Therefore, you cannot access to these menu to utilize this mode 
setting. Alternatively, you have set the receiver board to the receiver mode 
by setting the switch 1-8. 
 

3.14.3 Continuous TX / Pseudo Noise 
 

The Menu 3 initiates the modulated RF transmission. The data carried are 
pseudo random numbers. You can define the channel using the menu 9, 
and the output power using the menu 0. 

 
 

3.14.4  Continuous TX / Raw carrier 
 

The Menu 4 initiates the carrier transmission. The output power is not 0 dB 
as a reset default. You can define the channel using the menu 9. 

 

3.14.5 RX Mode 
 

The Menu 5 initiates the receiver mode. 
 

3.14.6 IDLE MODE 
 

The Menu 6 sets the UZ2400 into the IDLE mode. 
 

3.14.7 Standby MODE 
 

The Menu 8 sets the UZ2400 into the Standby mode. 
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3.14.8 Deep Sleep mode 
 

The Menu 9 sets the UZ2400 into the Deep Sleep mode. 
 

3.14.9 Power down mode 
 

The Menu 0 sets the UZ2400 into the Power down mode. 

 

3.14.10 Set RF channel 
 

The Menu A allows you to set the RF channel. 
 

3.14.11 Manually set UZ2400 register 
 
The Menu M allows you to set the UZ2400 registers. 
Please refer to the datasheet of the UZ2400 RF chip for the definition of 
registers. 

 
 

3.14.12 Resetting RF 
 

The Menu R allows you to reset the UZ2400 registers. 
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3.15 Terminating PM + 
 
 
 
 

In the PM + menu, select [File]→[Save Workspace].  
Then, select [File]→[Close Workspace].  
 
In the PM + menu, select [File]→[Exit PM +].  

 

 

 

 
PM + ends. 
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4 Hardware Specifications 
 
 
 
In this chapter, the hardware of TK-78K0R/KG3+UD will be explained. 
 

Microcontroller μPD78F1168 ※78K0R/KG3 

Clock 
External main system clock: 20MHz 
Subsystem clock: 32.768KHz 
Internal high-speed oscillation : 8MHz 

Interface 

USB (Mini B connector) 
RF connector (SMA) 
Connector of board in surrounding 
(CN1: not mounted) 
Connector for battery(9.0V-4.8V) 
MINICUBE2 connector 

Power supply 
voltage 

5.0V(Supply from USB)、 
9.0V(Supply from a battely,Min.6.5V) 

Input/output for 
operation check 

use 

・7LED x3 
・Push switch (SW3,SW4) 
・Dip switch (SW1) 
・Reset switch (SW6) 
・Temprature sensor (U1) 

Other hardware 
・Mode switch(SW1) 
・Power LED(LED1) 

* The name with bracket is the name printed on the board. 
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4.1 Layout of hardware functions 
 
 
 
 
 
 
 

FP1 

Universal area 

USB1 

SW1 

LED2～LED4

SW4 

SW3 

CON2 

 U1 RFVDD1  
 
 P150～P153
 
 
 
 SW2
 
 
 SW5
 
 LED1
 
 

JP1 
 CN2
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4.2 Hardware Functions 
 

4.2.1 SW1 
Bit1-5 of SW1 is Dip switch for operation mode setting. 
Bit6-8 are the Dip switch for general-purpose ports that connected to P80-P82. 

 
● For the use of ID78K0R-QB, use following settings. 

  SW1 
Bit 1 ON/OFF ※1 
Bit 2 ON 
Bit 3 ON 
Bit 4 OFF 
Bit 5 OFF 

 
※1 ON: The microcontroller stays being reset until ID78K0R-QB is started. 

OFF:  The microcontroller runs the programs stored in the flash memory as 

soon as it gets power supply.  

 

※2 If you use ID78K0R-QB, it uses P40 and P41 for communicating with host 

machine. Therefore, you cannot use P40 and P41. 

 
 

● To run the programs stored in built-in flash memory without using ID78K0R-QB, 
use following settings and re-supply USB power.  

 You can use the On-chip debug function with connecting a MINICUBE2. 
  SW1 

Bit 1 OFF 
Bit 2 OFF 
Bit 3 OFF 
Bit 4 OFF 
Bit 5 OFF 
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● For use of P13 (TXD3) and P14 (RXD3) connecting to μPD78F0730 as 
general-purpose ports without using ID78K0R-QB, set SW1 as follows and 
re-connect the USB to re-supply power. 
You can use the On-chip debug function with connecting a MINICUBE2. 

 

    SW1 
Bit 1 OFF 
Bit 2 OFF 
Bit 3 OFF 
Bit 4 ON 
Bit 5 ON 

 
 

● Bit6-8 are connected to following CPU pins 
It becomes “Low” if the switch is pushed, and it becomes “Open” if it separates. 
Please turn on pull-up resistor (PU8) with built-in CPU when using it.  

 
    SW1 

Bit 6 P80 
Bit 7 P81 
Bit 8 P82 
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4.2.2 SW2 
SW2 is a 4 directional switch with center push. If it is directed or pushed, the input 
is set to GND. Otherwise the circuit is open. Therefore please set the on-chip 
pull-up resistors (PU7) during initializing routine of your program code.  
(For more detail, please refer to the User’s manual(U17894) of the μPD78F1168 
CPU.) 
 
 

SW2 terminal list ( ALPS SKRHADE010) 

SW2 Signal 
name 

Terminal CPU name at 
connection destination Notes 

1 P72 P72/EX18/KR2 UP 
2 P73 P73/EX19/KR3 CENTER PUSH 
3 P74 P74/EX20/KR4/INTP8 LEFT 
4 P75 P75/EX21/KR5/INTP9 RIGHT 
5 GND GND  
6 P76 P76/EX22/KR6/INTP10 DOWN 

 
 
 UP 
 
 
 

RIGHLEFT  
 
 
 
 DOW

 
SW2 Directional switch 
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4.2.3 SW3,SW4 
SW3 and SW4 are tact switches. The port inputs are short-circuited to ground, 
while they are being pushed, and kept open otherwise. Therefore please set the 
on-chip pull-up resistors(PU7) during initializing routine of your program code. 
(For more detail, please refer to the User’s manual(U17894) of the 
μPD78F1168CPU.) 
 

SW3 and SW4 terminal list (ALPS SKQMBBE010) 

 Signal 
name 

Terminal CPU name at connection 
destination Notes 

SW3 P70 P70/EX16/KR0  
SW4 P71 P71/EX17/KR1  

 
 
 
 
 
 
 
 SW4 SW3
 
 

4.2.4 SW5 
SW5 is the reset switch. CPU can be reset by pushing. 

 
 

SW6 
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4.2.5 JP1 
This switches the power supply for CPU. 
 

1-2 short supply power from USB connected to USB1 
2-3 short supply power from batteries connected to CN2 
 

4.2.6  LED1 
This is the POWER LED. It is lighted when it gets power supply. 
 
 
 
 
 
 

4.2.7 LED2, LED3 and LED4 
LED2, LED3, and LED4 are available for applications. To make an LED on,  
please set the output port LOW. 
 

LED2, LED3 and LED4 Terminal list 

 Signal 
name 

Terminal CPU 
name at 

connection 
destination 

Notes 

LED2 P62 P62  
LED3 P61 P61/SDA0  
LED4 P60 P60/SCL0  

 
 
 
 
 
 
 

LED4 LLED3 ED2 
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4.2.8 FP1 
The connector for MINICUBE2. 
 

MINICUBE2 switch setting 
 
 
 

4.2.9 CON2 
Usually the jumper is short-circuited. If you want to measure the current 
consumed on the RF boards, you can measure it here. 

 

4.2.10 U1 
U1 is a temperature sensor. 
The temperature sensor is being connected to the MCU pin of "P27/ANI7". 
Therefore you can measure the output of the sensor using the analogue to 
digital converter, embedded in the MCU. You can convert the measured output  
voltage to a tempareture, referring to the conversion formul, available in the 
datasheet of the sensor, SII S-80120CNB. Please download the datasheet of 
the sensor from the internet web site of Seiko Instruments. 

 

4.3 Universal Area 
The kit has the universal area. Users can use this to develop custom circuit. 
 

4.4 Solder-short pad 
 
With using the solder-short pad to cut the circuit, users can customize the circuit. 
The solder-short pad looks like the picture below. 
To open, use cutter to cut the dent part. To short, put solder on the pad. 
 

 Solder-short pad   Solder-short pad 
(Open)                (Short) 

M1, T 

 
 

Solder-short pad name Before 
Shipment Connection 

1MΩ Pull-down 
Ｐ150～P153 Short Open when Ｐ150～P153 on CN1 is 

used. 
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4.5 Power supply 
 
There are two choices to supply power to the board, USB or a 006P battery via 
CN2. Please refer to 2.5 JP1 for the jumper setting.  

Please replace the battery with a new one, if the voltage level goes down to 
4.8V.  

Below the voltage level of 4.8V, functions of the board are not guaranteed. 
The battery voltage can be checked at the port as shown below. 

 
9.0V Battery check 

Signal 
name 

Terminal CPU 
name at 

connection 
destination 

Notes 

BT_MONI P26/ANI6 33.8% of the battery output is available at 
ANI6 
For instance,  

If the battery level is 9 V,  
 the level of the BT_MONI = 0.338×9.0 V 
                    = 3.042 V 

If the battery level is 6.5 V, 
the level of the BT_MONI = 0.338×4.8 V 

                   = 1.622 V 
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5  The IEEE 802.15.4 MAC Sample Program 
 

 
 
Two sample implementations utilizing the MAC stack are offered in this evaluation 
kit.  
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5.1 The MAC Sample program 1 :TextChat 
 
 
This chapter introduces the usage of MAC application 1 
 

The MAC Sample program 1 is developed to provide with a simple example 
to construct a star network utilizing the IEEE 802.15.4 PHY/MAC standard. 
 
The MAC Sample Program offers, 

1. Designation of a network coordinator in a star configuration 
2. Text chat between a coordinator and an end device 

 
To use the MAC Sample Program 1, you need to prepare at least two PC with 
a USB interface or one PC with more than one USB interface, and two 
TK-78K0R/KG3+UD boards.  
 
The MAC Sample Program 1 is provided in the form of the C source codes.  
 
If you wish to tailor the sample program to meet your specific needs, you can 
edit the source code, re-compile it with debug build to generate a load 
module file, then, start the debugger to load the tailored execution code on to 
the microcontroller for further debugging on the project manager PM +. In this 
procedure, the Flash programmer is not required. However, because the 
USB connection to instruct operation to the program is occupied for the 
debugging purpose, alternatively, you can make a release build to achieve a 
new hex file, on the project manager PM +. 
 

As a general remark, please respect your local regulation of electro-magnetic 
emission. In general, it is suggested to use the TK-78K0R/KG3+UD board in 
a radio anechoic chamber. 
 
It supports text chat for one coordinator and 4 end devices. 
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5.1.1 Programming to the TK boards 
 
For chatting, please prepare minimum 2, or maximum 5 TK-78K0R/KG3+UD boards. 
You need identical numbers of PCs. 
 
 
Some laptop PCs do not support full functionality of hyperterminal. 
This software has been confirmed at 
NEC MATE MY25XCZEG 
NEC VERSAPRO VY10A/C-4,  
and, NEC VERSAPRO VY10F/BH-M 
 
Start PM+, and open the file 
"C:¥TK78K0R¥SAMPLE_KG3+UD¥TK78K0RKG3UD_Sample1¥TK78K0RKG3UZ_Sa
mple1.prw". 
 
Select "Tools" on menu bar, then "Compiler options". 
 
Select "Preprocessor" tab on "Compiler Options" window. 
 
To write programs on the first TK-78K0R/KG3+UD, enter 
"CPU78K0R,DCDC,MAC_ADDR=0x0001" on "Define Macro". For the second and third 
TK-78K0R/KG3+UD, enter "CPU78K0R,DCDC,MAC_ADDR=0x0002" and 
"CPU78K0R,DCDC,MAC_ADDR=0x0003". The number "x" of " MAC_ADDR=x" must 
be a unique number. 
 
Click re-build button on PM+ or select "Build" -> "Rebuild" on menu bar to rebuild. 
 
Start the debugger from PM+, then write different programs to each TK-78K0R/KG3+UD 
(for the information about how to write programs, refer to "3.1 Starting PM+" through "3.9 
Starting integrated debugger (ID78K0R-QB)").) 
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5.1.2 Setting up the board to your PC 
 
Set the TK-78K0R/KG3+UD as shown below. 
Connect it to PC with USB cable. 
Confirm the power LED on TK-78K0R/KG3+UD is lighted.  
 

JP1 1-2short (USB side) 
Bit1 OFF 
Bit2 OFF 
Bit3 OFF 
Bit4 ON 
Bit5 ON 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 
 
Start Hyper Terminal with referring to "3.14The RF Test Program". 
 
Settings of the Hyper Terminal should be set as follows. 
 

 Bits per second 115200 

Data bits 8 

Parity None 

Stop bits 1 

Flow control None 

 
 
 
 

 
Press SW5 (RESET SW) once after Hyper Terminal is started. The sample application starts 
after resetting. 
 
In the same way, connect the other TK-78K0R/KG3+UD board to PC, and start Hyper 
Terminal. If the PC has more than one USB ports, you can connect to more than one 
TK-78K0R/KG3+UD boards, and you can start more than one Hyper Terminals for those 
COM ports on each board. 
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4). Hyper Terminal 
 

Now you will find the following opening menu in the window. 
If not, please try the RESET button on the board. 
 

 
 

Command? > 

 

 

 My MAC extended address 

 = 123412349ABC0001 

 << 78K0R+UZ Sample Application: Skyley Networks >> 

Then, press Enter, 
 

 
 

[Help] ------------------------- 

S: Send Message 

M: MLME Associate test 

C: Start Coordinator test 

-------------------------------- 

 

Command? > 

Please do the same for your other boards and PCs. 
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5.1.3 Designation of a coordinator 
 

Now, you must decide which board is a coordinator. 
Go to the PC of the coordinator board, and press C. 
 

 
 
Now the coordinator has started. 

 

5.1.4 Network Association 
 

For other PCs for other boards, please press M. 
 

 
 

Command? >M 

 

> MLME-ASSOCIATE.request 

> MLME-ASSOCIATE.confirm 

>  Associated ShortAddr:4321 

>                Status:00 

 

Command? > 

Command? >C 

 

> MLME-START.request 

> MLME-START.confirm 

>  Status:00 

 

Command? > 

Now, this particular board was associated to the network as an end device 
with the short address of 4321. Please repeat this step for your third, fourth, 
and possibly fifth board. 
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On the coordinator side, you will find the following message, if the 
association is successful. 
 

 
 

Command? > 

-------------------------------- 

 

[Help] ------------------------- 

S: Send Message 

>  from 123400019ABC0001 associated to 4321 

 

> MLME-ASSOCIATE.indication 

 

5.1.5 Text Chat 
 

Now the network is prepared for you to start text chat between an end 
device and the coordinator. 
 
At first, you may start with the coordinator. 
 
Press S, then input the short address of an end device, 4321 in this 
example, 
then, input your text message, up to 102 bytes.  
 

 
 

Command? > 

 

> MCPS-DATA.request 

> Send to (short address) ? 4321 

> Message ? Hello! 

Command? >S 
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You will find the following message on the end device, 4321. 
The sender’s short address is “1975”, and the PAN ID is 2420 in this 
example. 
 

 
 

>  from 1975/2420 

Hello! 

Command? > 

> MCPS-DATA.indication 

Now, you can reply from the end device “4321” to the coordinator “1975” by 
inputting S, 1975, and your reply text. 
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5.2 The MAC Sample Program2 : LED Control 
 
 
 
The MAC Sample program 2 is developed to provide with another simple example 
to construct a star network utilizing the IEEE 802.15.4 PHY/MAC standard. 
 
The MAC Sample Program 2 offers, 
1). Designation of a network coordinator in a star configuration 
2). If you push a switch on the n th end device, an LED on the coordinator board 
blinks on and off n times. 
 
To use the MAC Sample Program 2, you need to prepare one PC with a USB 
interface and two TK-78K0R/KG3+UD boards or more boards, up to 5.  
The MAC Sample Program 2 is provided in the form of the C source codes with 
the MAC library.  
 
If you wish to tailor the sample program to meet your specific experiment, you can 
edit the source code, re-compile it with debug build to generate a load module file, 
then, start the debugger to load the tailored execution code on to the 
microcontroller for further debugging on the project manager PM +. In this 
procedure, the Flash programmer is not required. However, because the USB 
connection is occupied for the debugging interface, the USB connection is not 
available for applications. In this application example, Hyperterminal with USB 
connection offers information on the network association. However, the LED 
operation can be made without Hyperterminal. Therefore, you can use the USB 
connection for debugging for the LED operation. Alternatively, you may make a 
release build to achieve a new hex file, on the project manager PM +.  
 

As a general remark, please respect your local regulation of electro-magnetic 
emission. In general, it is suggested to use the TK-78K0R/KG3+UD board in a 
radio anechoic chamber. 
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5.2.1 Programming to the TK boards 
 

Prepare TK-78K0R/KG3+UD boards (2 to maximum of 6 boards). 
You also need at least one PC to write programs, however no PC is needed when running the 
programs. 
 
One TK-78K0R/KG3+UD board will be "Coordinator". Other 1-5 boards will be "End device". 
You use the same project files for both "Coordinator" and "End device". 
 
Start PM+ and open the file 
"C:¥TK78K0R¥SAMPLE_KG3+UD¥TK78K0RKG3UD_Sample2¥TK78K0RKG3UZ_Sample2
.prw". 
 

Click the build button    or select "Build" on menu bar, then "Build" to build. 
Start the debugger from PM+ and write programs to each TK-78K0R/KG3+UD board. 
(for the information about how to write programs, refer to "3.1 Starting PM+" through "3.9 
Starting integrated debugger (ID78K0R-QB)") 
 
The address of each board will be set by pressing SW2 when the boards start up (when 
power is supplied). Therefore, you use the same programs to all boards. 

 

5.2.2 Starting up a coordinator 
 
 

By connecting the TK-78K0R/KG3+UD which takes the role of "Coordinator", you can monitor 
those programs running (you can monitor the output itself with LED without PC). 
When you wish to connect PC, set the TK-78K0R/KG3+UD as follows. Then, connect USB 
cable to PC. Confirm the power LED is lighted after connecting the USB cable. 
 

JP1 1-2 short (USB side) 
Bit1 OFF 
Bit2 OFF 
Bit3 OFF 
Bit4 ON 
Bit5 ON 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 
 
 
 

- 96 - 



Start Hyper Terminal with referring to "3.14The RF Test Program". 
 
Settings of the Hyper Terminal should be set as follows. 

 
 Bits per second 115200 

Data bits 8 

Parity None 

Stop bits 1 

Flow control None 

 
 
 
 

 
 

6). After you open the window of the HyperTerminal, please push the reset 
button on the board. Now you will find the following opening message in 
the window. 
If not, please reconfirm the COM port number of the USB connection. 

 

 
Now the coordinator has started up successfully. 

- 97 - 



5.2.3 Starting up end devices 
 

Set TK-78K0R/KG3+UD settings as follows when you use PC connected to 
TK-78K0R/KG3+UD which takes the role of "End device". Then, connect USB cable to PC. 
Confirm the power LED is lighted after connecting the USB cable. 

 
JP1 1-2 short (USB side) 

Bit1 OFF 
Bit2 OFF 
Bit3 OFF 
Bit4 ON 
Bit5 ON 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 
 
 

When you wish to use TK-78K0R/KG3+UD as itself, set JP1 to BATTERY side (2-3short) and 
SW1 to all OFF, then connect battery. 
 
You must set the position of SW2 when you supply power to TK-78K0R/KG3+UD. 
The TK-78K0R/KG3+UD board functions of each SW2 position are described as follows. 

 
 

Position of Joy Stick during 
start-up 

Function Extended Address 

Default Coordinator 0x1234XXXX9ABC0001 
Up End Device 0x1234XXXX9ABC0002 
Center End Device 0x1234XXXX9ABC0003 
Left End Device 0x1234XXXX9ABC0004 
Right End Device 0x1234XXXX9ABC0005 
Down End Device 0x1234XXXX9ABC0006 

※The “XXXX”of Extended Address filled with”MAC_ADDR=0xXXXX” that configured 
at “Compiler Options” -> “Defined Macro”.

- 98 - 



If you start-up a board while keeping the Joy Stick up, you will see the 
following message on the HyperTerminal. 
 

 
 
A short address of “4352” was assigned to the board. 
A short address is assigned sequentially, independent from the long 
address. 
Then, if you start-up the third board while keeping the Joy Stick center, you 
will see the following message on the HyperTerminal. 
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5.2.4 Operation 
 
The coordinator generates beacon at channel 11 of 2405 MHz. 
LED4 on the board is ON. 
 
An end device makes a network association. If successful, LED2 on the 
board is ON. 
 
If you push SW3 on an end device, LED4 on the coordinator blinks. 
And, if you push SW4 on an end device, LED3 on the coordinator blinks. 
 
The number of times of blink depends on the sequence the end device joined 
in the network. For instance, if an end device is the third end device for the 
network, the LED will blink three times. 
 

LED on Coordinator SW on End Device 
LED2 SW3 
LED3 SW4 

 
The following example shows, the SW3 on the fifth end device, “4356”, was 
pushed. You will see the LED2 on the coordinator will blink 5 times.  
The default PAN ID of this network is “2420”.  
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6 Troubleshooting 
 
 
This chapter describes how to solve troubles you may face.  
 

6.1 If you cannot find USB driver when you connect PC to the kit 
 
Check Point 1 

If you use USB hub, do not use it. (USB hub is not supported) 
 
Check Point 2 

Check if you installed "Starter Kit USB Driver" in "1.2 Installation of Development 
Tools". If not, install the driver. 

 
Check Point 3 

Check if the settings of the switch on the kit are correct with referring to "1.3 
Installation of USB Driver". 

 
Check Point 4 

If above 3 check points are confirmed, disconnect the USB cable from PC and 
re-connect again. It should show the "Found New Hardware Wizard" wizard. Operate 
the installation with referring to "1.3 Installation of USB Driver". After the installation, 
make sure you go through "1.3.3 Completion of USB Driver Installation" to confirm the 
USB driver installation.  

 

6.2 Error when you start the debugger 
 
There could be several reasons to make errors happen. 
The solving processes differ depending on errors. Please check the error message first. 
The solving processes for each error are as follows. 
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6.2.1 "Can not communicate with Emulator..." (F0100 or A0109) 
 
Check Point 1 

If you use USB hub, do not use it. (USB hub is not supported) 
 
Check Point 2 

Check if the settings of the switch on the kit are correct with referring "1.3 Installation 
of USB Driver". 

 
Check Point 3 

Confirm the USB driver installation with referring to "1.3.3 Completion of USB Driver 
Installation". 

 
Check Point 4 

If above 3 check points are confirmed, close the debugger and disconnect the USB 
cable from PC. Re-connect USB cable properly to both the PC and the kit, and then 
re-start the debugger.  
 
 

6.2.2 "Incorrect ID Code." (Ff603) 
 

This error occurs when the security ID stored on microcontroller built-in flash memory is 
different from the ID code you entered at the start of debugger.  
 

Security ID entry area at the start of debugger 

 
 
Check Point 1 

Enter correct security ID and click OK on the configuration window. 
 
Check Point 2 

If you forgot the security ID, you have to erase the microcontroller built-in flash 
memory. Before erasing, check if you actually set the security ID with referring to 
"3.4Configuration of Linker Option". Also remember the code you set for the security 
ID. 
After this, erase the flash memory with referring to "7.4Erase of flash memory". 
 

6.2.3 "The on-chip debug function had been disabled in the device." 
(F0c79) 

 
This error occurs when the value at address C3H (On-chip debug option byte) in 
microcontroller built-in flash memory is incorrect. You need to erase the flash memory.  
 
Check Point 1 

Check if you actually set the correct on-chip debug option byte with referring to 
"3.4Configuration of Linker Option". If it is not correct, then set correctly.  

 
Check Point 2 

Erase the flash memory with referring to "7.4Erase of flash memory". 
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6.2.4 "Disabling the on-chip debug function is prohibited." (F0c33) 
 

Basically, this error occurs when you start (download) the debugger without doing the 
settings described at "3.4Configuration of Linker Option". Do the same checking processes 
as"4.2.3 The on-chip debug function had been disabled in the device. (F0c79)". 
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7 Other Information 
 
 
This chapter explains some useful operation techniques of development tools and 
circuit diagram of the kit for developing of user programs. 
 
 
 
 7.1 Create a new workspace (project) 
 
 

7.2 Register additional source file 

 
 7.3 Debugger tips
 
 
 7.4 Erase microcontroller built-in flash memory 
 
 
 7.5 Circuit diagram
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7.1 Create a new workspace 
 

Now, create a new workspace and project. 
PM+ allows you to create a new workspace with following "New WorkSpace" 
dialog.  
Select "File" on PM+ menu bar, then "New Workspace...". 

   

"New WorkSpace" dialog 

opens 

<Description of items> 

Workspace File Name: 
 -> Specify the name of the workspace file that

manages the project files. 
.prw is automatically suffixed as the file type. 
A project file (.prj) of the same name is
simultaneously created. 

Folder: 
 -> Specify the folder for saving the workspace file by

writing its absolute path. 
    This item can be selected from a reference

dialog box by pressing the Browse… button. 

Project Group Name: 
 -> Specify this item if wishing to manage
multiple projects together in function units. 
If nothing is specified, this item is the same as
the workspace file name. 

 

 

 

 

 

 

 

 

 

 

 

 Microcontroller Name: 
 -> Specify the name of the microcontroller to be

used. 

 

Device Name: 
 -> Specify the name of the device to be used. 
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The concrete information set here is 

described on the following pages 



 
 

 Input the workspace information setting

as follows. 

 
Workspace file name 
 → 

 
 
 test 

C:¥78K0R 

78K0R 

uPD78F1168_A0 

 
Folder 
 → 

Project Group Name 
 → (no input) 

Microcontroller Name 
 → 

Device Name 
 → 

 

 
 
 
 
 
 
 
 
 

Click  Next >  button 

 

 
Click  Yes  button 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click  Detail Setting  button 
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Set the version of tools as 

follows.  
CC78K0R：W2.12 

RA78K0R：W1.33 
ID78K0R-QB：V3.60 

 
Select tools as above screenshot, then click  OK  . 

 

 

 

 
Click  Next >   
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Select ID78K0R-QB V3.60 

 
Click  Next >   

 

 
 

Click  Next >   

 
 

Check the project information 

settings 

Click  Finish    
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Project “test" was registered. 

 
This completes workspace and project creation. 
Additional source files can be registered at any time thereafter. 
For details, refer to "7.2 Register additional source file". 
Also, you need to do the settings for on-chip debug. Please refer to "3.4 Set 
Linker Options", "3.5 Set Compiler Options", and "3.7 Check Debugger Settings". 
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7.2 Registration of new source files 
 
 
Now, we learn how to register new source files. 
The following example shows how to register two additionalsource files of “b.c” 
and “c.c” with source file “a.c” already registered. 
Place the cursor on a source file in the Project window of PM+, and select [Add 
Source Files…] displayed in the right-click menu. 
 

 

 

 

Select source files "b.c" and 
"c.c", then click  Open   

 Multiple source files can be selected by clicking them while keep pressing  Ctrl  key.
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Source files "b.c" 
and "c.c" are added 

to the project. 
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7.3 Debugger tips 
 
 

This section describes some useful techniques for the debugger (ID78K0R-QB). 

 

7.3.1 Change display of buttons 
 
Execution controls (run, stop, step-in debugging, reset, etc) and opening 
functional window can be made by below buttons. However, it could be difficult 
to know which button does what.  
 

 
 
In this case, select "Options" on menu bar, then "Debugger Options". Check 
"Pictures and Text" on setting area. 
 

 
 

With this setting, the buttons display the text as well, so that it is easier to know 
what they are. 

 

 
 

7.3.2 Display source list and function list 
 

When you wish to see source file list or function list, select "Browse" on menu 
bar, then "Other" -> "List" to open the list window. The information in the 
windows is synchronized. Therefore, it is not just for referring to the list, but it is 
useful when you wish to update files or functions.  

 

Source window shows "game1" When you click "game1"... 
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7.3.3 Set/delete breakpoints 
 

Breakpoints are executed by clicking lines in which " * " is displayed 

"B" is displayed in the line where a breakpoint is set. 

Breakpoints are deleted by clicking "B". 

 
 
 

Click 

 
 
 
 
 
 
 
 
 

Breakpoint was set 
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7.3.4 Display global variables 
  
With using Watch Window, you can display global variables. There are several ways to 

register global variables to watch window. In this section, how to register from source 

window is described. 

 

①Right-click the variable on source window, then select "Add Watch..."  

 

 
 

②Add Watch dialog opens. Click  OK  . 
 

 
 

③Adding a variable to watch window is completed. 
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7.3.5  Display global variables while programs are running 
 
RAM, general-purpose register, and SFR can be referred by the pseudo 
real-time monitor function even when the programs are running. 
Select "Option" on menu bar, then "Extended Option...". Configure the settings 
for "RAM Monitor And DMM". 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This completes the settings. 
 
Note: 

Check 

Specify the sampling interval time of the pseudo real-time monitor function. 
The sampling time can be specified from 0 to 65500 with unit of 100ms. 
It will not monitor if it is set to "0" or blank. 

・ The user program momentarily breaks upon a read. 
・ Do not use the pseudo real-time monitor function while using the memory 

window. It uses the system resources significantly as it monitors the 
displaying memory as well. 

・ It is recommended to close the memory window when you use the pseudo 
real-time monitor function. 
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7.3.6 Display local variables 
 
Local variable window is used to display local variables. 
By clicking the button below, you can open the local variable window. 
Unlike global variables, local variables cannot be displayed when programs are 
running. 

 
 
 

 
 
 
 
 

7.3.7 Display memory and SFR contents 
 
By clicking the button below, you can open the memory window. 
 
 
 
 
 
 

 
 
 
 
 

By clicking the button below, you can open the SFR window. 
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7.4 Erase of flash memory 
  
 
 

If the On-Chip Debug Option Byte is set to "Do not erase data of flash memory in 
case of failures in enabling on-chip debugging" and if you forget the security ID, 
you need to erase the flash memory completely. 
Ｔo erase the flash memory, please follow the steps below. 
 
Double-click to open the file "exk0r32ocfg.exe" under the directory "C:¥Program 
Files¥NEC Electronics Tools¥TK-driver" (as the installation directory is default). 
 
"78K0R Starter Kit Setting" starts. 
Set "Flash Memory" to " Erase flash memory at debugger start up ", then click "Setting". 

 

 
 
Restart the integrated debugger (ID78K0R-QB). 
Now the ID code is the default value of 0xFFFFFFFFFFFFFFFFFFF.  
 

 

Input
「FFFFFFFFFFFFFFFFFFFF」 

 

 

When you could confirm the debugger is working, open "exk0r32ocfg.exe" again. This time, 
select "KEEP flash memory at debugger start up", then click Setting. 
(Because there is a limit of erasing times for flash memory, it is recommended to try not to 
erase the flash memory too many times). 
 
If you want to change the Security ID code to your favorite secret code, please 
input the secret code in the Linker option. Then, you will compile the program. 
After then, you have to input your secret security code everytime your starting up  
the debugger. If you input a wrong code, you will find the ollowing warning. 
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※ ID Code 
The ID Code is a mechanism to prevent an unwelcome third party from accessing your 
source code by initiating the debugger. Therefore, it is recommended to modify the ID Code 
from the default value to secure your original source code. However, once you modify it, then, 
if you forget the security ID or mistakenly over-write 0x00(value) to the address of 0xC3, the 
debugger ID78K0R-QB is unable to access to the CPU via OCD interface. In this case, you 
have to start over from erasing all data in the Flash EEPROM. Then, you can define the new 
ID Code. You may load your source code from the debugger with a load module file. 
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7.5 BOM List & Circuit diagram 
 
 
 
Here is the BOM List & circuit diagram of the evaluation kit. 
 
● CUP board BOM list 

No. Mount 
Quantity 

Mount Parts Reference Unmount Parts Reference Type Parts No Maker Note 

1 0  CN1  Connecter HIF3H-50DA-2.54DSA HIROSE Not 
Mounted 

2 1 CN2   Connecter S2B-ZR-SM3A-TF JST   
3 2 CN4,CN3   Connecter TFM-110-02-S-D-A-K-TR SAMTEC   
4 14 C1,C5,C6,C7,C8,C15,C16,   Chip ceramic cap 0.1uF     
    C17,C18,C19,C20,C21,C22,           
    C23           
5 3 C2,C12,C14   Chip ceramic cap 0.47uF     
6 2 C3,C4   Chip ceramic cap 10pF     
7 2 C10,C9   Aluminum 

Electrolytic Cap 
10uF/25V     

8 2 C13,C11   Aluminum 
Electrolytic Cap 

4.7uF/25V     

9 1 FP1   Connecter HIF3FC-16PA-2.54DSA HIROSE   
10 1 JP1   Jumper FFC-3AMEP1 HONDA   
11 0   JP2 Jumper FFC-3AMEP1_xxx HONDA Not 

Mounted 
12 4 LED1,LED2,LED3,LED4   LED PG1112H STANLY   
13 1 L1   Filter BLM41PG750S MURATA   
14 2 MR3,MR1   resister module CN1J4-105 KOA   
15 1 MR2   resister module CN1J8-103 KOA   
16 0   RFVDD1,P150,P151,P152,   SS   Solder pad
      P153         
17 4 R1,R2,R3,R5   Chip resister 1.2K     
18 2 R16,R4   Chip resister 100     
19 1 R6   Chip resister 1M,1%     
20 1 R7   Chip resister 360K,1%     
21 2 R9,R8   Chip resister 33     
22 2 R14,R10   Chip resister 10K     
23 2 R11,R15   Chip resister 1.5K     
24 2 R13,R12   Chip resister 3.0K     
25 3 R18,R20,R21 R17,R19 Chip resister 4.7K     
26 2 R23,R22   Chip resister 0     
27 1 SW1   DIP SW CHS-08B COPAL   
28 1 SW2   SW SKRHABE010  ALPS   
29 3 SW3,SW4,SW5   Push SW SKQMBB ALPS   
30 0   TPU1,TPU2,TPU3,TPU4,TPU5,   TPU   Through 

hole 
      TPU6,TPU7,TPU8,TPU9         
31 0   TP1,TP2,TP3,TP4,TP5   TP   Through 

hole 
32 1 USB1   Connecter UX60A-MB-5ST HIROSE   
33 1 U1   TEMP sensor S-8120CNB SEIKO   
34 1 U2   IC uPD78F1168GC-UEU-AX NECEL   
35 1 U3   IC LM1117MPX-3.3 NS   
36 1 U4   IC uPD78F0730 NECEL   
37 1 U5   IC SN74LVC1G125DCK TI   
38 1 U6   IC SN74LVC2T45DCU TI   
39 1 U7   IC SN74LVC2G07DCK TI   
40 1 U8   IC SN74LVC2G126DCU TI   
41 1 Y1   Resonator CSTCE20M0V53 MURATA   
42 1 Y2   Resonator MC-306 32.7680K-A0 EPSON   
43 1 Y3   Resonator CSTCE16M0V53-R0 MURATA   
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● RF board BOM list  
 
No. Mount Quantity  Mount Parts 

Reference 

Unmount Parts 

Reference 

Type Parts No Manufacturer 

1 2 C37,C43   Chip ceramic cap C0402CRNP09BNR50 Yageo 

2 1 C38   Chip ceramic cap CC0402CRNPO9BN1R8 Yageo 

3 2 C1,C53   Chip ceramic cap C0402ZRY5V5BB105 Yageo 

4 LQG15HN5N1S02 Murata 

4R 

1 L3,L5   Chip ceramic inductor

AL02BT5N1M Viking 

5 1 L4   Chip ceramic inductor LQG15HN6N8J02 Murata  

6 1 R5   Chip resister RC0402JR-0710M Yageo 

7 4 C5,C39,C52,C63   Chip ceramic cap C0402ZRY5V7BB103 Yageo 

8 2 C2,C4   Chip ceramic cap C0805ZKY5V6BB106 Yageo 

9 1 C3   Chip ceramic cap C0603ZRY5V6BB475 Yageo 

10 2 C21,C54   Chip resister C0402JRNP09BN150 Yageo 

11 1 XTAL_2   Resonator G5 Series 32.768kHz Ecera 

12 1 XTAL_1   Resonator 7M32000044 TXC 

13 2 C60,C64   Chip resister C0402JRNP09BN330 Yageo 

14 1 C48   Chip ceramic cap C0402JRNP09BN390 Yageo 

15 5 C19,C40,C44,C55,C57   Chip ceramic cap CC0402JRNPO9BN470 Yageo 

16 1 C45   Chip resister C0402ZRY5V7BB104 Yageo 

17 0   R1 Chip resister RC0402JR-070R Yageo 

18 1 L2   inductor LQH2MCN8R2M02 Murata 

19 1 CON2   Connecter   HO YANG SYONE 

20 2 CN3,CN4   Connecter SFM-110-02-S-D-A MetaTech 

21 1 S1   Connecter 7865NS502BD000B BO-JIANG 

22 1 U1   UZ2400.D   UBEC 
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● CUP board schematic 
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● RF board schematic  
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8 Mode setting of the board 
 

 
The combination table of the switch of this board is shown. 
 
 
 
 
 
 
 
 
 
  
 
  SW1 

JP1  
 
 
 
 

Usage case 
SW 

Normal  Debug Debug (MINICUBE2)

Bit1 OFF OFF/ON  ※1 OFF 
Bit2 OFF ON OFF 
Bit3 OFF ON OFF 
Bit4 ON OFF ON 

SW1 

Bit5 ON OFF ON 
 
※1 

ON: The microcontroller stays being reset until ID78K0R-QB is started. 
OFF: The microcontroller runs the programs stored in the flash memory as 

soon as it gets power supply.  
 
JP1 Power supply setting  

1-2 short supply power from USB connected to USB1 
2-3 short supply power from batteries connected to CN2 

 
 

- 125 - 


	1  Introduction
	2  Preparations
	2.1  Development Tools, Sample Programs, and the MAC Library
	2.1.1 Integrated Development Environment PM + V6.31
	2.1.2 Device file DF781188 V3.00
	2.1.3 C Compiler CC78K0R W2.12 : Code size limited version
	2.1.4 Assembler RA78K0R W1.33 : Code size limited version
	2.1.5 78K0R integrated debugger ID78K0R-QB V3.60
	2.1.6 78K0R Starter Kit Setting
	2.1.7  Starter kit USB driver 
	2.1.8 The RF Test Program
	2.1.9 IEEE 802.15.4 MAC Library
	2.1.10 The MAC Sample Program1 : Text Chat Program
	2.1.11 The MAC Sample Program2 : LED Control

	2.2 Installation of Software Development Tools
	2.2.1 Start-up of the installation CD-ROM
	2.2.2 Installation of the software development tools.
	Please do not use 2-byte characters, such as umlaut in the directory name, where the product is to be installed.
	 Note on the version of Windows 
	If the language of the Windows is not English, a file transfer error during installation might be observed. In this case, please abort the installation in the language, and re-install it in an English version of Windows.
	The identical problem may be observed, if a language other than English is specified as the system language in the “Regional Settings Properties” tab.

	 
	2.2.3 Uninstall
	2.2.4  File Configuration in PC

	USB Driver
	2.3.1 Install to Windows XP
	2.3.2  Install to Windows2000
	2.3.3 Confirmation of the installation 

	2.4  Sample Environment
	2.4.1  Installation of the sample programs
	2.4.2  File Configuration of the sample program


	3  Experiences
	Starting PM +
	3.2 Introduction to PM +
	3.3 Loading Workspace (Project)
	3.4  Configuration of Linker Option
	3.4.1 "Output1" Tab
	3.4.2  "Output2" Tab

	3.5  Configuration of Compiler Option
	3.5.1 "Extend" Tab
	3.5.2  "Startup Routine" Tab

	Configuration of Debugger setting
	3.7  TK board setting
	3.8  Creating execution format
	Starting integrated debugger (ID78K0R-QB)
	3.10  Introduction of the integrated debugger(ID78K0R-QB)
	3.11  Executing a program
	3.12  Stop a program
	3.13  Terminating integrated debugger (ID78K0R-QB)
	3.14  The RF Test Program
	3.14.1 Procedure for one to one transmit/receive test
	3.14.2  PER test / receiver
	3.14.3 Continuous TX / Pseudo Noise
	3.14.4  Continuous TX / Raw carrier
	3.14.5 RX Mode
	3.14.6 IDLE MODE
	3.14.7 Standby MODE
	3.14.8  Deep Sleep mode
	3.14.9 Power down mode
	3.14.10 Set RF channel
	3.14.11 Manually set UZ2400 register
	3.14.12 Resetting RF

	Terminating PM +

	Hardware Specifications
	4.1 Layout of hardware functions
	4.2 Hardware Functions
	4.2.1 SW1
	4.2.2  SW2
	4.2.3  SW3,SW4
	4.2.4 SW5
	4.2.5  JP1
	4.2.6  LED1
	4.2.7 LED2, LED3 and LED4
	4.2.8  FP1
	4.2.9 CON2
	4.2.10 U1

	4.3 Universal Area
	4.4 Solder-short pad
	4.5  Power supply

	5   The IEEE 802.15.4 MAC Sample Program
	5.1  The MAC Sample program 1 :TextChat
	5.1.1  Programming to the TK boards
	5.1.2  Setting up the board to your PC
	5.1.3  Designation of a coordinator
	5.1.4 Network Association
	5.1.5 Text Chat

	5.2  The MAC Sample Program2 : LED Control
	5.2.1 Programming to the TK boards
	5.2.2 Starting up a coordinator
	5.2.3  Starting up end devices
	5.2.4  Operation


	Troubleshooting
	6.1 If you cannot find USB driver when you connect PC to the kit
	6.2 Error when you start the debugger
	6.2.1 "Can not communicate with Emulator..." (F0100 or A0109)
	6.2.2 "Incorrect ID Code." (Ff603)
	6.2.3 "The on-chip debug function had been disabled in the device." (F0c79)
	6.2.4 "Disabling the on-chip debug function is prohibited." (F0c33)


	7  Other Information
	7.1  Create a new workspace
	7.2 Registration of new source files
	 
	7.3 Debugger tips
	7.3.1 Change display of buttons
	7.3.2 Display source list and function list
	7.3.3 Set/delete breakpoints
	7.3.4 Display global variables
	①Right-click the variable on source window, then select "Add Watch..." 

	7.3.5  Display global variables while programs are running
	7.3.6 Display local variables
	7.3.7 Display memory and SFR contents

	 
	Erase of flash memory
	Restart the integrated debugger (ID78K0R-QB). Now the ID code is the default value of 0xFFFFFFFFFFFFFFFFFFF. 
	 
	When you could confirm the debugger is working, open "exk0r32ocfg.exe" again. This time, select "KEEP flash memory at debugger start up", then click Setting.
	(Because there is a limit of erasing times for flash memory, it is recommended to try not to erase the flash memory too many times).
	※　ID Code


	 
	7.5 BOM List & Circuit diagram

	8  Mode setting of the board

